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C h a p t e r

CREATING A WML PROJECT
Site Builder can operate in two modes: HTML and WML. In the WML mode, you can 
create Web publications consisting of WML output that can be published to a WAP server 
for accessing via an Internet-enabled device.

When you first start Site Builder, it opens in the HTML mode by default. But you can 
easily switch to the WML mode, and you can then stay in that mode—or toggle easily 
between the two modes—as suits your needs.

In an HTML project, you use a copy of the default project file Default.tcp. In the WML 
mode, you use a copy of DefaultWML.tcp, a default project file that is designed specially 
for WML projects. (Both project files are located in the ...\Resources\en folder of your 
Content Publisher directory. Copies are available in the Support folder on the Content 
Publisher distribution media.)

Please note the following:

! The WML publications you create in Site Builder use templates that target the Nokia 
micro browsers (which support WML standards 1.1 and 1.2) and the Phone.com micro 
browser. The behavior of these publications when viewed with any of the numerous 
other micro browsers currently in use with Internet-enabled devices may not be what 
you expect. 

! We recommend that you do not add HTML or XML source documents to a WML 
project, as this will not produce valid WML.

! The Help topics you view when you click the Help buttons in Site Builder are 
designed for HTML projects and should be used only as a guide when you are creating 
WML projects. 
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ENTERING THE WML MODE
Follow these steps to enter the WML mode:

1. Click Applications Options on the View menu to open that dialog box.

2. Click Dialogs to switch to that tab dialog.

The default settings for the Dialogs tab dialog in Application Options. Once you select 
Show Project Type selection dialog, the Project Type dialog box will open the next 
time you start a new project. You can then switch to the WML mode to create WML 
projects.

3. Select Show Project Type selection dialog.

4. Click OK.

You are now ready to start a WML project.

STARTING A NEW WML PROJECT
Follow these steps to start a new WML project:

1. Click New ( ) on the standard toolbar to start a new project.

The New Project Type dialog box opens.
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2. Select Create a WML Project. 

You can also select Don’t show this dialog again if you plan to stay in the WML 
mode. If you do, when you’re ready to return to the HTML mode, you can return to 
the Applications Options dialog box (see page 1-5) and select Show Project Type 
selection dialog once again. (Clicking Don’t show this dialog clears the Show 
Project Type selection dialog check box in Application Options.)

3. Click OK to close the New Project Type dialog box. 

You have opened a copy of DefaultWML.tcp. You will see <Unnamed-WML> in the root 
of the publication hierarchy and also as the default publication name in the Publication 
Properties dialog box, which has already opened.

4. You can rename the publication. Select <Unnamed-WML> and type WMLProject. 
Then click OK. 

You are now in the WML mode, ready to start your WML project. The differences 
between the HTML and WML modes may not be immediately apparent.

On the main window, one difference is that the Layout button ( ) on the toolbar is 
disabled. (You cannot create a frameset, table or custom table layout for a WML 
publication.) Note, also, the special icon next to the root publication in the Publication 
Hierarchy pane. As soon as you open any project in Site Builder, you can check the 
publication icon to identify the project type.

Once you add a document to the project, you will quickly see other differences.

1. Click Add Document ( ) on the toolbar and select SourceDocWML.doc from the 
..\Samples\en\Formatted folder.

The Choose Template dialog box opens.
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There are only three default templates available for the cards (pages) of a WML 
project. These templates relate to the specific micro browser that will be used to view 
the WML output.

First, you can see that there are only three default templates available for cards (pages) 
in a WML project. You can select each of the templates, in turn, but you won’t see 
many differences in the Preview window. (Obviously, you can still create new 
templates, basing them on the default ones.)

Each template supports a different micro browser. The essential difference between 
Nokia 1.1 and Nokia 1.2, for example, is that the latter (which supports WML 
standard 1.2) permits use of the <pre> tag for preformatted text. (There was also 
attribute changes between 1.1 and 1.2.). Your choice of template will depend on the 
device you want to support.

2. Select Nokia (WAP 1.1).

3. Click OK to close Choose Templates and return to the main window. Let’s explore 
the standard features in Site Builder to see the differences between a WML and 
HTML project. Remember: many of the features you are used to in HTML are simply 
not available in WML, which is a much simpler format.
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APPLICATION AND PROJECT OPTIONS
Let’s begin with a quick review of application and project options. The Application 
Options dialog box (open from the View menu) is essentially the same whether you are in 
an HTML project or a WML one. However, in addition to the new option in the Dialogs 
tab dialog for toggling between the two modes (see the following figure), the Default 
Output Extensions panel in the General tab dialog now includes the wml extension, which 
is used by default for all documents added to a WML project.

The default wml extension is used by default for all WML projects. Like the htm extension 
for HTML projects, you can change this, if you want. 

The Project Options dialog box (also from the View menu) displays a greater number of 
differences when in the WML mode. Gone are the following panels and their options: 
HTML Generation, Containing Frame Name (there are no frames in WML publications), 
Print Publishing (you do not print from an Internet-enabled device), and Conditional 
Disclosure (which isn’t relevant).

ELEMENT SETUP
The Element Setup property sheet is usually your first stop when creating any new project. 
It’s usually best to check elements, styles, patterns, and metadata, and to create new 
elements and map your content, as appropriate, before you begin to format output, set 
navigation links, and so on.
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There are fewer default elements in a WML project and no default ranks, styles, patterns, 
or metadata. But you can still use ranks, styles, patterns, and metadata in your WML 
project, just as you would in an HTML one. (No styles or patterns are shown here because 
the source document SourceDocWML.doc is a manually formatted document—all the 
content is assigned to the Normal style—and the document was imported with the default 
None selected in the Choose Template dialog box. As a result, all the content was mapped 
to the Default Paragraph element.) 

With one other exception, the options available in an HTML project are available for 
WML, too. That exception is the absence of a Page TOC, which you cannot create or 
promote elements to. (To check this, select an element and click Properties. On the 
General tab dialog you will see that the Include in Page TOC check box is disabled.)

FORMATTING
The Formatting property sheet is significantly different for a WML project. Many of the 
HTML features and settings are simply not relevant in WML. The next figure shows the 
reduced number of tab dialogs available. Moreover, there are fewer settings and options 
available in these tab dialogs.
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Let’s walk through each tab dialog, in turn.

! Character—For WML output, there are no font or font size options, and CSS 
(cascading style sheets) is not an option. (WML output is obviously very plain, and 
the font and font size are governed by your micro browser.) You can still have bold 
and italic text, for example, but there are fewer text effects available. As you can see, 
Table Overrides is still an option, but your micro browser may not support tables. 

! Paragraph—Here, your only choice is alignment. 

! Tables—You have similar functionality as for HTML projects, but your micro 
browser may not support tables.

! Graphics—Note the option to convert to WBMP for an Internet-enabled device. This 
is the default conversion format when you create a WML project. Three graphics 
formats—WBMP, BMP, and GIF—can, in fact, be used for WML publications. 
However, not all WAP-enabled devices support WBMP, and the micro browsers that 
are targeted by the three default templates do not support a common graphics format. 
Of course, you must work with much smaller-sized graphics files in a WML project 
(just as your source documents need to be smaller, too). 

! WML—Here, you can insert WML or scripting code before or after the content 
associated with the selected element (just as you might insert HTML code in the case 
of an HTML project).
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NAVIGATION
There are significant differences between setting up navigation for a WML project versus 
an HTML project. The following figure shows the complete set of options available for 
your WML project.

The order of selected links is very important. (The same links are available when you open 
this dialog box for a reference page.) 

Keys to Navigation
To permit navigation through your WML publication, you can assign some of the links 
shown in the above figure (you’re unlikely to want to assign all of them). The links you 
select will be assigned to the two unmarked buttons on your device (which we’ll refer to as 
the “left blank button” and “right blank button”). How these buttons are used, by default, 
varies between devices. (For the Phone.com micro browser, for example, the left blank 
button is used for the Accept or OK command.) By selecting navigation links here, you 
can override the default settings.

Some pointers:

! The first navigation link you select in Navigation will be assigned to the left blank 
button. All others you select will be assigned to the right blank button.
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! If you select three or more navigation links in total, the two or more links that are 
assigned to the right blank button will appear in a menu in the browser window when 
you click that button.

! However, if your TOC, say, has only one card (page), the Next Page link would be 
redundant. In that event, if you assign the Next Page link, it would drop out 
completely and the next navigation link you selected would take its place. 

! Likewise, a Previous Page link has no meaning if there is no previous page. So if you 
are on the first card (page) of a document, the Previous command (link) wouldn’t be 
available. However, it would be available for all successive pages you scroll to.

! The order of the link types in Navigation is therefore important.

! You can use drag-and-drop to change the default order of the links. Simply left-click 
the link type you want to move, and, with the mouse button held down, move the link 
type up or down the list to reposition it wherever you want it to be. The next figure 
shows some of the links moved to create a new order.

Note that some links have been dragged to the top of the list of links. The key thing is the 
order in which the selected links appear on the list. With this selection, Next Page will be 
assigned to the left blank button and the other three to the right blank button of the device.

Note: The assignment of navigation links, as described above, assumes that you are 
targeting a device that allows for the assignment of links in this fashion. On a Nokia 
device, for example, all links will appear together on a separate card.
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Note the Link Text column. You can edit this, if you want. Select the link type you want to 
edit, click the Properties button, and in the Link Properties dialog box, enter the text you 
want to use. Obviously, a character limit will dictate how long the link text can be (which, 
again, varies with micro browsers).

GLOBALS
In Globals, again we’re working with a reduced number of tab dialogs, and fewer options 
in some of the tab dialogs that are available.

! Titles—Practically unchanged for WML projects (the page component option isn’t 
available).

! Head—Include WML at Top of File displays the WML declaration for the template 
that you selected for your project (and therefore the micro browser you are targeting).

Note: Most devices and emulators will not display content if the declaration is missing. 
However, you can edit the declaration in the event that a new DTD is issued and you want 
to supply it to your users.
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The Include WML Before the First <card> Tag entry contains the “prev” reference 
that enables the Back button on Internet-enabled devices. You generally shouldn’t 
change this entry.

The WML declaration (in the top window) is required for your WML output to 
display in a micro browser. The <prev> reference in the bottom window is generally 
required or the Back button of your device may not work.

! Card—This is the same as for an HTML project (where the tab dialog is named 
Body). Here, you can create event handles for a card in your WML output. 

! Options—What’s new here—and a key ingredient in the creation of WML 
publications—is the Maximum WML File Size. This setting influences the eventual 
size of your uncompressed WML output. The default is 1397 bytes for each file 
(card), but you can change this number. See the next section. 

! WML—This is essentially the same as the HTML version.

! Layout—There are more limited options here, because inevitably you have fewer 
layout elements in a WML publication.

A WORD ABOUT FILE SIZE
Each device has certain memory constraints. You must carefully control your WML 
output if it is to display successfully in an Internet-enabled device. In fact, if an individual 
file is greater than 1397 bytes (compressed), it won’t display.

It’s important to understand the following:

! When Site Builder translates your project, it generates uncompressed WML files.

! The size of these uncompressed WML files is controlled by the following setting in 
the Options tab dialog of Globals:

Note: In the WML standard, a deck (or file) can contain one or more cards. In Content 
Publisher, however, the default templates all treat one card as being equal to one page. So 
in Content Publisher, a deck is the same as a file is the same as a card is the same as a page.

Note: The Options tab differs slightly for reference pages (see Adding a Reference Page 
(page 1-14)).
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! The default WML file size is 1397 bytes. (This figure is simply the lowest common 
denominator for devices that use a compiled deck. It may be quite conservative in 
some instances.)

! Site Builder first splits an output file based on the element you select (the default is 
Heading 1). It then examines each output page to determine whether it is over the 
1397 byte limit. If it is, Site Builder splits the file again, to ensure that no output WML 
file is greater than the byte-size limit you set.

! If Site Builder splits a file to meet the 1397 file size maximum, it tries to do so at a 
space character—but may not succeed. As a result, a file may be split in the middle of 
a word (and most certainly in the middle of a sentence). This suggests the need to 
severely “chunk” your source content to make it suitable for WML publishing.

! Once your WML output is published to a WAP server, it must then pass through a 
WAP gateway in order for it to reach an Internet-enabled device. The WAP gateway 
compresses the WML files. 

! It is these compressed files that must be no larger than 1397 bytes (otherwise, the 
micro browser won’t display them).

! Suppose the WML files that Site Builder generates compress to 200 bytes. This would 
leave about 1197 bytes available to the device that you are targeting. (As already 
noted, the default 1397 byte size may be conservative.)

! In other words, conceivably you could set the file size limit in the Options tab to be 
much greater than 1397 bytes (say, 3000 bytes) and still be successful publishing to 
your target audience. The only thing to do is test, test, test. Try translating with 
different byte-size settings and see how successful your publishing efforts are. (This is 
something you obviously can’t test on an emulator.) 

! You may note that your translated WML output may contain certain placeholder 
comments that cause the file size to be exceeded. During publishing, these comments 
are removed, thereby meeting the file size constraint.
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TRANSLATING A SIMPLE PROJECT
Typically, you’ll want to test all your WML output before you publish it to a WAP server 
and make your content available to your users. Consider using an emulator. The one 
described here is available from www.openwave.com.

Follow these steps to translate a simple project:

1. With WMLProject.tcp open in Site Builder, click Translate ( ) on the toolbar.

2. Click View ( ) . What you will see in your browser, of course, is the same WML 
markup you saw in the Preview window of the Choose Template dialog box when you 
added the source document to the project (see Figure ).

However, with your emulator installed and running, you can easily view the real 
WML output in the micro browser. Let’s say that your translated output resides in 
C:\Document\WMLTest. The first output file will be SourceDocWML.wml (you will 
have several output files because of the default splitting and the restriction on WML 
file size).

3. In the Go field of your emulator, type:

File://C:/Document/WMLTest/SourceDocWML.wml (note the forward slashes).

4. Press Enter.

5. Your WML output will display in the micro browser.

By typing “File://” plus the path for your output WML file on your hard drive in the Go 
field, you can view your WML output in your micro browser:

Note: View the behavior of your WML publication in an emulator as simply a guide. In 
fact, you should generally expect to encounter different behavior between an emulator and 
the Internet-enabled phone it is designed to emulate. For example, some emulators don’t 
like spaces in folder or file names (though this is unlikely to be a problem with the device 
itself). You need to test thoroughly. 
Content Publisher: Creating a WML Project 1-13

www.openwave.com


Creating a WML Project
That’s one simple test. Once you add a reference page, you can explore some additional 
features specific to WML projects.

ADDING A REFERENCE PAGE
Follow these steps to add a reference page:

1. With WMLProject.tcp still open in Site Builder, click Add Reference Page ( ) 
on the standard toolbar to open the Add Reference Page dialog box.
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Index and Query templates are not available for WML projects. You can use Default 
TOC, but you will have to add a declaration to this template for your published 
reference page to be viewable.

2. Under Type, accept the default, Table of Contents.

Note that Index and Query reference pages are not available for WML. Remember, 
too, that the TOC, LOF, and LOT template are actually the same template. You can 
create a TOC with either one. (Three options are available to allow you to build 
different kinds of reference pages for the same project.)

3. From the Templates drop-down list, select Nokia TOC (WAP 1.1). This reference 
page template is designed as a companion to the Nokia (WAP 1.1) template that you 
associated with the source document for cards (pages).

In addition to a companion TOC template for each of the templates used for cards 
(pages), there is also a Default TOC template available. This might be used for 
targeting other micro browsers. However, it does not contain a WML declaration (you 
can check the Head tab dialog of Globals to confirm this), and most emulators and 
devices will not display any content if the declaration is missing. In order to use 
Default TOC, therefore, you would have to add a declaration.

4. Click OK to return to the main window.

5. In the Contents pane, double-click Table of Contents.wml (with a pause between 
clicks) and change the name of the output file to TableofContents.wml. 
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This is necessary here because the emulator we’re using doesn’t like spaces in folder 
and file names (and won’t display the page, as a result). It may not be necessary with 
other emulators and it will not be an issue with any Internet-enabled device you target.

6. Click Translate ( ).

7. In the Go field of the emulator, enter:

File://C:/Document/WMLTest/TableofContents.wml

You should now see a very simple table of contents for your WML publication, 
with a single jump to take you to first card (page) of your main WML output, 
SourceDocWML.wml.

You might care to experiment now by adding navigation links to both the Table of 
Contents.wml and SourceDocWML.wml. Experiment with the various links available 
and see how they behave in the emulator that you are using.

Here’s one last thing to note:

1. Select TableofContents.wml in the Contents pane and click Globals ( ) on the 
toolbar.

2. Click Options to open that tab dialog. Note the panel at the bottom of the tab dialog 
(available only when a reference page is selected).

This setting is used to determine the linking mechanism for navigating between the TOC 
and your other content. It is yet one more instance where micro browsers vary. The 
<a href> option is designed for Nokia micro browsers (and is selected by default when you 
choose a Nokia reference page). The alternative <select> is suitable for Phone.com micro 
browsers (and becomes the default when you use the Phone.com reference page).
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THE BIG PICTURE
Here are some key points to bear in mind as you begin to create and test WML 
publications in Site Builder:

! Test everything thoroughly. Emulators, devices, and micro browsers vary widely in 
how they interpret WML markup. 

! Depending on your target audience and the number of micro browsers you are seeking 
to satisfy, you may need to create a project with multiple publications with the same 
content in each publication but a different template (for a different micro browser) 
associated with the content.

! The WML declaration (see the Head tab dialog of Globals) is important, because it 
defines the “flavor” of WML being targeted.

! The usability of TOCs varies greatly, depending on the linking mechanism that is 
employed (see previous section).

! The <prev> tag should always be defined (see the Head tab dialog of Globals). On 
some devices, the Back button will not work without it.

! The file size constraint (the default is 1397 bytes) applies to compressed WML output 
after you publish. You may be able to set the maximum size much higher.
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A p p e n d i x

A.THIRD PARTY LICENSES

OVERVIEW
This appendix includes a description of the Third Party Licenses for all the third party 
products included with this product.

! Apache Software License (page A-1)

! W3C® Software Notice and License (page A-2)

! Zlib License (page A-4)

! General BSD License (page A-5)

! General MIT License (page A-5)

! Unicode License (page A-6)

! Miscellaneous Attributions (page A-7)

APACHE SOFTWARE LICENSE
* Copyright 1999-2004 The Apache Software Foundation.

* Licensed under the Apache License, Version 2.0 (the "License");

* you may not use this file except in compliance with the License.

* You may obtain a copy of the License at

*      http://www.apache.org/licenses/LICENSE-2.0

* 
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* Unless required by applicable law or agreed to in writing, software

* distributed under the License is distributed on an "AS IS" BASIS,

 * WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.

 * See the License for the specific language governing permissions and

 * limitations under the License.

W3C® SOFTWARE NOTICE AND LICENSE
* Copyright © 1994-2000 World Wide Web Consortium, 

* (Massachusetts Institute of Technology, Institut National de 

* Recherche en Informatique et en Automatique, Keio University). 

* All Rights Reserved.  http://www.w3.org/Consortium/Legal/

* 

* This W3C work (including software, documents, or other related items) is

* being provided by the copyright holders under the following license. By

* obtaining, using and/or copying this work, you (the licensee) agree that

* you have read, understood, and will comply with the following terms and

* conditions:

* 

* Permission to use, copy, modify, and distribute this software and its

* documentation, with or without modification, for any purpose and without

* fee or royalty is hereby granted, provided that you include the following

* on ALL copies of the software and documentation or portions thereof,

* including modifications, that you make:

* 

*   1. The full text of this NOTICE in a location viewable to users of the

*      redistributed or derivative work.

* 

*   2. Any pre-existing intellectual property disclaimers, notices, or terms
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*      and conditions. If none exist, a short notice of the following form

*      (hypertext is preferred, text is permitted) should be used within the

*      body of any redistributed or derivative code: "Copyright ©

*      [$date-of-software] World Wide Web Consortium, (Massachusetts

*      Institute of Technology, Institut National de Recherche en

*      Informatique et en Automatique, Keio University). All Rights

*      Reserved. http://www.w3.org/Consortium/Legal/"

* 

*   3. Notice of any changes or modifications to the W3C files, including the

*      date changes were made. (We recommend you provide URIs to the location

*      from which the code is derived.)

* 

* THIS SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS," AND COPYRIGHT HOLDERS

* MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT

* NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR

* PURPOSE OR THAT THE USE OF THE SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE

* ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS.

* 

* COPYRIGHT HOLDERS WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL OR

* CONSEQUENTIAL DAMAGES ARISING OUT OF ANY USE OF THE SOFTWARE OR

* DOCUMENTATION.

* 

* The name and trademarks of copyright holders may NOT be used in advertising

* or publicity pertaining to the software without specific, written prior

* permission. Title to copyright in this software and any associated

* documentation will at all times remain with copyright holders.

*
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ZLIB LICENSE
* zlib.h -- interface of the 'zlib' general purpose compression library

  version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied

  warranty.  In no event will the authors be held liable for any damages

  arising from the use of this software.

  Permission is granted to anyone to use this software for any purpose,

  including commercial applications, and to alter it and redistribute it

  freely, subject to the following restrictions:

  1. The origin of this software must not be misrepresented; you must not

     claim that you wrote the original software. If you use this software

     in a product, an acknowledgment in the product documentation would be

     appreciated but is not required.

  2. Altered source versions must be plainly marked as such, and must not be

     misrepresented as being the original software.

  3. This notice may not be removed or altered from any source distribution.

  Jean-loup Gailly jloup@gzip.org

  Mark Adler madler@alumni.caltech.edu
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GENERAL BSD LICENSE
Copyright (c) 1998, Regents of the University of California

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, 

are permitted provided that the following conditions are met:

"Redistributions of source code must retain the above copyright notice, this 

list of conditions and the following disclaimer. 

"Redistributions in binary form must reproduce the above copyright notice, this 

list of conditions and the following disclaimer in the documentation and/or other 

materials provided with the distribution. 

"Neither the name of the <ORGANIZATION> nor the names of its contributors may be 

used to endorse or promote products derived from this software without specific 

prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. 

IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 

PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGE.

GENERAL MIT LICENSE
Copyright (c) 1998, Regents of the Massachusetts Institute of Technology

Permission is hereby granted, free of charge, to any person obtaining a copy of this 

software and associated documentation files (the "Software"), to deal in the 

Software without restriction, including without limitation the rights to use, copy, 

modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, 

and to permit persons to whom the Software is furnished to do so, subject to the 

following conditions:
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The above copyright notice and this permission notice shall be included in all 

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 

PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 

HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 

CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE 

OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

UNICODE LICENSE
UNICODE, INC. LICENSE AGREEMENT - DATA FILES AND SOFTWARE

Unicode Data Files include all data files under the directories 

http://www.unicode.org/Public/, http://www.unicode.org/reports/, and 

http://www.unicode.org/cldr/data/ . Unicode Software includes any source code 

published in the Unicode Standard or under the directories 

http://www.unicode.org/Public/, http://www.unicode.org/reports/, and 

http://www.unicode.org/cldr/data/.

NOTICE TO USER: Carefully read the following legal agreement. BY DOWNLOADING, 

INSTALLING, COPYING OR OTHERWISE USING UNICODE INC.'S DATA FILES ("DATA FILES"), 

AND/OR SOFTWARE ("SOFTWARE"), YOU UNEQUIVOCALLY ACCEPT, AND AGREE TO BE BOUND BY, 

ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT 

DOWNLOAD, INSTALL, COPY, DISTRIBUTE OR USE THE DATA FILES OR SOFTWARE.

COPYRIGHT AND PERMISSION NOTICE

Copyright © 1991-2006 Unicode, Inc. All rights reserved. Distributed under the 

Terms of Use in http://www.unicode.org/copyright.html.

Permission is hereby granted, free of charge, to any person obtaining a copy of the 

Unicode data files and any associated documentation (the "Data Files") or Unicode 

software and any associated documentation (the "Software") to deal in the Data 

Files or Software without restriction, including without limitation the rights to 

use, copy, modify, merge, publish, distribute, and/or sell copies of the Data Files 

or Software, and to permit persons to whom the Data Files or Software are furnished 

to do so, provided that (a) the above copyright notice(s) and this permission notice 

appear with all copies of the Data Files or Software, (b) both the above copyright 

notice(s) and this permission notice appear in associated documentation, and (c) 

there is clear notice in each modified Data File or in the Software as well as in 

the documentation associated with the Data File(s) or Software that the data or 

software has been modified.
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THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 

FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO 

EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR 

ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES 

WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF 

CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH 

THE USE OR PERFORMANCE OF THE DATA FILES OR SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used 

in advertising or otherwise to promote the sale, use or other dealings in these Data 

Files or Software without prior written authorization of the copyright holder.

________________________________________Unicode and the Unicode logo are trademarks 

of Unicode, Inc., and may be registered in some jurisdictions. All other trademarks 

and registered trademarks mentioned herein are the property of their respective 

owners

MISCELLANEOUS ATTRIBUTIONS
Adobe, Acrobat, and the Acrobat Logo are registered trademarks of Adobe Systems 
Incorporated.

FAST Instream is a trademark of Fast Search and Transfer ASA.

HP-UX is a registered trademark of Hewlett-Packard Company.

IBM, Informix, and DB2 are registered trademarks of IBM Corporation.

Jaws PDF Library is a registered trademark of Global Graphics Software Ltd.

Kofax is a registered trademark, and Ascent and Ascent Capture are trademarks of 
Kofax Image Products.

Linux is a registered trademark of Linus Torvalds.

Mac is a registered trademark, and Safari is a trademark of Apple Computer, Inc.

Microsoft, Windows, and Internet Explorer are registered trademarks of Microsoft 
Corporation.

MrSID is property of LizardTech, Inc. It is protected by U.S. Patent No. 5,710,835. 
Foreign Patents Pending.

Oracle is a registered trademark of Oracle Corporation.

Portions Copyright © 1994-1997 LEAD Technologies, Inc. All rights reserved.

Portions Copyright © 1990-1998 Handmade Software, Inc. All rights reserved.

Portions Copyright © 1988, 1997 Aladdin Enterprises. All rights reserved.
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Portions Copyright © 1997 Soft Horizons. All rights reserved.

Portions Copyright © 1995-1999 LizardTech, Inc. All rights reserved.

Red Hat is a registered trademark of Red Hat, Inc.

Sun is a registered trademark, and Sun ONE, Solaris, iPlanet and Java are trademarks 
of Sun Microsystems, Inc.

Sybase is a registered trademark of Sybase, Inc.

UNIX is a registered trademark of The Open Group.

Verity is a registered trademark of Autonomy Corporation plc
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